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Windows Win7/8/10/11 (64bits)

Linux Centos7.0/7.5/8.2 (64bits)
Ubuntu18.04/20.04/22.04 LTS
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2 BETE

B2 SR U (DR RIRR 2060 2228 4, D0 R I7 AU license #2KL

R4 &4 (Gowin License Server), T3t B W T #k:

Windows 54t =i 2R AN “ ZIHHAFE for Win (Vx.x.x)”;
Linux R4¢ R =2 B4R, SO IR for Linux (VX.x.x)”;

Windows F# 4t T HI7F 5 license AU S 2 FoN “ =W AT e AR
2528 for Win”;

Linux R4t KT 52 license AU S Bt 2 B 4a e, A “&
VAR AR 2545 for Linux”.

BAF BT, RSN MR R
Bt B AR AR A PRV XXX RN AR A S
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https://www.gowinsemi.com.cn/software/1

3 A 3.1 Windows FR 442235t

3 REHR%

3.1 Windows ARGt R %

Windows £4t N %37 —8, Wi =R 228, RIERRr7ES, %@
R R RS T g H %, N, SIAE PC%@@JLH%
#E77 A

3.2 Linux R

ZYRFE Linux RGP SCRIN & KRR R G e 3 7 380 ok,
RISE Rk 228, 4atff ka2 A “tar -zxvf *tar.gz”.

3.3 BHREKIEEM
3.3.1 Windows RG R %&

® HRERYRAT, HISEH 360. TF 5 B T A R R A
® IR A ﬁEPIjZ A SO AR
3.3.2 Linux 243

® Programmer (1)) 3h 7 Z A% root KUK ;
® R, B “chmod” fir &S 58 AT AT SO AL IR .«

34 BHRZBR

Windows £ 4t %235 R I, 23 7£ % %% H 5% path\Gowin_Vx.x.x €& IDE.
Programmer )23 H 5 & 13 IR B AT AT S0, W 3-1 frzn. Linux &
B IR 23 H SR A EE IR B A PAT S, HoAth H 5% (IDE. Programmer)
)5 Windows R4 [E . 415 LL Windows &4t NHIA A =6 20255 H 5%,
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3 Bt 3.4 Bt H 3

& 3-1 zlEREZBR
Marne Date maodified Type Size
IDE 6/18/2021 03:30 File folder
Programmmer 6/18/2021 08:50 File folder
(9 uninst.exe 6/18/2021 08:50 Application 09 KB

34.1 IDE REBF

IDE SCHFI N =R 235 H 3%, i 3-2 Fras . bin SCHEJ R aT $47 S04
H3%, & gw_ide.exe.floorplanner.exe 25 n] #1714, Xili bin\gw_ide.exe
ATHER I doc IR = IEAHRH A PHa R SRS . simlib TN

R FE

& 3-2 IDE B3%#

MName Date modified Type
bin 5/25/2020 5:38 PM File folder
data 5/25/2020 5:39 PM File folder
doc 5/25/2020 5:39 PN File folder
ipcore 5/25/2020 5:39 PN File folder
plugins 5/25/2020 5:39 PN File folder
share 5/25/2020 5:39 PN File folder
simlib 5/25/2020 5:39 PN File folder

3.4.2 Programmer &% HR

Programmer SC2F A =R g FE a8 ) 2235 H 5%, Wik 3-3 Fiz. bin SCHF
Je A AT SO H 3%, Wi bin\programmer.exe 7] B4 5 5 = I i FE A% o
& 3-3 Programmer B3R

Mame Date modified Type
bin 8/18/2021 08:50 File folder
doc 61872021 08:50 File folder
driver B/18/2021 08:50 File folder

3.4.3 uninst.exe

uninst.exe, E1E = AT $ AT S0, X5 uninst.exe, #H Gowin VxX.x.x
Uninstall #2548, W& 3-4 fiox, B “Yes”, BIAJEIZE IR
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3 Bt

3.4 B HR

SUG501-1.5

E 3-4 A EEHRRAE

Gowin V1.9.8.01 Uninstall

Are you sure to remove Gowin V1.9.8.01 and its all components
completely?

B0

E(N)
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4 {4 License fit & 4.1 License fij/i

4 1 License Bt &

4.1 License &/}
KA A AT license B HE
4.1.1 License X
B4t license & — Mg &R, HE=FRIESHPET, HEERM
PRI AR P AR R AR, DL s = = AR R 55

At license = EAL A = license XA W3 (MAC: Media Access
Control) Hudik. fi FH HARE .

4.1.2 License &I

license 287, HET S 8TE R license(node-locked ) FITiF i 7Y
license(floating).

TABETY license, &I T AN EEHIEFTIRELT] license, FREUT A
BiE Y license WA P RBEESUE 1T RiIALES HAE R BCEE, HABHLES EikAE
1% license.

7% s license, &2ET7E R38N N HE 1) license x 554 4 B H ik iy
SR license, A M P HEEIRS], A RKHPEHEERS], %R
WA FAE—HF CGEERTED #RrT LER .

4.1.3 License
Windows #:/f &4t & Linux #/F &£ 437 i F§ node-locked 5% floating
license, license EAKKfE ik .

1. BAH P HIA — &8P PC, license Al =yR#R 223X A ML 2 I,
A2, F AT LA ] node-locked license, 7] LL{# F floating license:;

2. AW BIAZa580UR PC, BT PC fEFR—AN &M, &4 PC I
#R R T =UR, 4, TLLHI floating license. floating license 23 7E
FEMAN—& PC £, &M/ mrLlisid#ER:iZ PC 1) IP 3kHX floating
license, 41K 4-1 Fir;
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4 #A% License Bt B

4.1 License faifr

SUG501-1.5

& 4-1 Bk %588 & % Floating License

FNENES
N

floating .
license \\

ZAH P HIE £ 6 AR PC (i PC #J52& Windows #:E R %), Al

H PC fEF— Rk, AT LLHE floating license. 7F Windows AR %5 %%

EEE R G0 3 = UE % floating license, F /7 AT LAZE H & PC & K
J P s AR S T B 55D 7 1) Windows IR%5 %%, B 3248 1% Windows
iR %5 e =R K license, W1 4-2 Fik;

ZAH P HAE 2 8 50U PC (T PC ¥J7& Windows &%1), AT
PC 7E[A]—/N e ™, 0] L floating license. fE linux #:4F 24t F %
2 =i X floating license, F /" AIUFEH O PC EEFIK T Canidid
Exceed onDemand Desktop % F' i & 5% ) Vi i linux A% 2%, BEEZMH
% linux fR%5#s LI =8 X license, W 4-2 iR,

ZAH P HIA 2 6 50U PC (T PC #52 linux #1E RS, i
PC fE[H—AN=1 M, 7] PLH i floating license. 7£ Windows R 55 #5 £
1E 248 223 =5 % floating license, ' AJLLZE EH Ef) PC 5% (T
i RDP #430) #| Windows IR %525, E#EAEH % Windows JiR % #% L=
P license, Ui 4-2 Flrw;

ZAH P BE 2 G 540U PC (Frfs PC #4# linux 24t), Firfi PC 1E
7] —AN eIk %, 7] LU floating license. 7E linux BR1E 2245 1 2238 4
J floating license, F /Al LAfEH & PC I (lnilid VNC Sever) 1
] linux AR%5 3%, BEIEMHZ linux ikS 8 L= X license, Wi 4-2
PR
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4 {4 License fit &

4.1 License faifr

B 4-2 5548 223 =R KX Floating License

Fifloating license

4.1.4 %i@i&ﬂtgﬁéﬂﬂﬁ - ¥

Windows 3B MAC itk 773 (BL Windows 10 1))
1. $TJF “IFis” 3, 1 “miRnrff;
2. FEFRHIEA A& H N ipconfig/all,

3. TER[FIFME B A R rT sk EU ) E skt
4-3 Windows10 &% MAC it

% [m] 22
inlel 4-3 2L B A SR .

E¥ Command Prompt

8 Microsoft Corporation. All rights reserved.

C:\Users\jinfeng.GOWIN-ITC>ipconfig /all

Windows IP Configuration

Enabled. . e« o+« . .t No

g gDHiﬂ—itE.EF

fic DNS Suffix

Cannection

Preferred)

6-60-B4-48-4D-7E-BC-2

Linux 3RHL MAC Hilik #7520 (LA Centos7.5 A1)

1. FTF &

2. fEZ&um¥i N\ “Isbinfifconfig”, %A%,

3. fERERE B EI A SR EE A, A 4-4 ZEHE LR B TR

SUG501-1.5
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4 %A License Bl B 4.1 License fij4

[ 4-4 Centos7.5 &% MAC ik

[ om0 ~=1% /sbin/ifconfig
lo: flags=73<UP,LOOPBACK,RUNNING> mtu 65536
inet 127.0.0.1 netmask 255.0.0.0
ineté ::1 prefixlen 128 scopeid 0x1O<host>
loop txqueuelen 1000 (Local Loopback)
RX packets 160 bytes 12640 (12.3 KiB)
RX errors © dropped @ overruns @ frame @
TX packets 160 bytes 12640 (12.3 KiB)
TX errors @ dropped @ overruns ® carrier @ collisions ©

p8pl: flags=4099<UP,BROADCAST,MULTICAST> mtu 1500
| ether 8c:ec:4b:4d:ff:f2 | txqueuelen 1000 (Ethernet)
RX packets @ bytes © (0.0 B)
RX errors © dropped © overruns @ frame ©
TX packets © bytes 0 (0.0 B)
TX errors @ dropped © overruns ® carrier @ collisions ©

4.1.5 =R License HiF
=I5 license A 1E E =2 SR B 0 B B & @ T Bk R FAE B HIE .
HiE License HI L W& 4-5 ffizs .
& 4-5 EMHE License W

HiELicense

RREHR R ARSI L] | REFIHEERP S R SRR I3091ERE.

siELicense

B
1

E=f

B
ki

Pl
aBrl:

BEAMS:

BEABE:

BEE A GRS

BERAEM
HEMMACHE:

licenses8Y: O]l OHt=3

EEESHZE OWindows  OLlinux

EmEE CREaF [(BmkelE CERSeF OfdEssE (HiEgaE CRusiis OHf

license 2574. “{UANL” & node-locked license, “FLZA” £ floating
license.

H15 1 license 15 FH R BRI A —4F, i B 2 2505 7T LA R IR i . Floating
license BRINSCHF 10 NPT, A SR P AT E PR ).
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https://www.gowinsemi.com.cn/software/1?section=license

4 #A% License Bt B 4.2 Windows R4 #1f License fit &

4.2 Windows ZZtE4E License BL B

Windows £ 4t license Bt & 77 30—, L Windows10 £ 4t i # o

IR SG, T R 2% license IEATRE A, W15 license AS1E
W, ARSI Error $EORHE, WK 4-6 Fros. B “OK” J5, 3
it License Manager XJ1fAE, WK 4-7 FioR.
4-6 License Error {27E
% ERROR X

License verification failed.
file can not be opened

4-7 License Manager 3iE1E

) License Manager — O >
d

License Configuration

®) Use Local License File () Use Floating License Server

License File: |C:i/Gowin/gowinlic Browse...

Checl

Apply for License BB License Close

421 HEHIER license

F—IRECE license, 1L K 4-7 X1EHELE S “Use Local License File”,
EREAHAT S8 E Y license SCAF, i “Browse:s+”, INIISCAFIAE. H
o R “Check” %417 AR BE R IEF TS, &I &#H INFO $#2R
fE, 7R “License is OK”. MAC Hulib #1477 license B &AL H B, 40
K 4-8 fli7~. ¥y “Save”, BIAJ{RAE YA E .

WA FE license FLE, AI{ER AT HEA L, iy “Help >
Manage License---”, i “License Manager” XfifHE, WP 4-7 fiax, B
AT T license AL & .
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4 #A% License Bt B 4.2 Windows R4 #1f License fit &

& 4-8 F iR license FEIER IR RIE
W INFO b4

'6' License is QK.
"  Host-ID: FOBESES3BAGO3

Exp. date: 2022-10-21

422 Z 8 License
I license 75 EAH A & = 2 SRR I license SAUIR S5 BAT AL,

AR BL R =R 5 208 30 license #2RUIR %5 -

® Gowin License Server #4247 3 5

® Gowin License Server % & ¥l H 33 3

® Gowin License Server ¥ & Windows %555 5.

wSITRIN
CIBGi oY NG s =kriE

1. HEXE “license_server.exe” JA#l. 75 EHF s A license X4 (i
gowin_license.lic) E#%| “license_server.exe” FfERIE N, FiF S
license XA 24~ “gowin.lic”, XUili “license_server.exe”;

2. TRV, I E I, #ATa4: path\license_server.exe -s
path\gowin_license.lic -b. 335K 4-9 fis.

e -s: JIN#K license 14
e -b: JGHIZELT license k%
o -p: BEWHOS, BERik 10559.

SUG501-1.5 11(22)




4 #A% License Bt B 4.2 Windows &4 1F License fic &

& 4-9 Gowin License Server BEIE [

EX Ch\windows\system32\cmd.exe - C\Users\jingkun\Desktop1.2.8.01\license_server.exe -s C\Users\jingkun\Desktopigowin.lic -b - m} s

L8014 licens

BRI JG, fE “License Manager” XHiGHE 1%\ floating license
MR 252800 1P Mk, Wikl 4-10 Bk

4-10 BCE Floating License

&) License Manager — O x>
g

License Configuration

() Use Local License File  (® Use Floating License Server

License Server: |192.168.21.100 | port

Check

Apply for License B3 License Close

B N 7% Check "4 n] LA B8 15 342 52, 1 P 22 3 Y INFO
PORHE, EIR “Serveris OK”. AL floating license IR %5 %% 1P il ¥
5 M5 license A 20W#UEH I, Wi 4-11 Pk

SUG501-1.5 12(22)




4 %A License Bl B 4.2 Windows R4 #f License it &

& 4-11 ;2 5B license ERER IR RIE
G INFO X

Server is OK.
Address: 192,168.31.100:10559
Exp. date: 2022-10-21

ANE AP license (ERL B B ¥ )5, B HB2¥ license it &
5 EENLH H 3 N R E SC\IDE\bin\gwlicense.ini /1, W1 4-12 FiiR.
4-12 License BL & H

| gwlicense.ini - i25=% - | X
MiHE #EE B0 EE|EN EEH)
[license]

lic="192.168.31.100:10559"

Unix (L 253 {7 100%

E!

MR VR 2236 H 3 F L E SR 2, TCiE R A7 gwlicense.ini SCHF, #idi “Save”
P 2230 TCVERAF AR R . U B gwlicense.ini U N Ao i “B8k” 5 “H N7
IRLRR, BPA iz ek @ i>2 20, WK 4-13 fim. BUIRMESUS, FIREET license
fic &
4-13 CHILBRIEEX

gwlicense.ini Properties x

General Securty Details Previous Versions
Object name: G \gowinRelease ' Gowin_setup'Gowin_VW1.5.3.02|

Group or user names:

ER Athenticated Users

S cvoTEm

t Administrators (SWEG-JINFENG \ Administrators)
SR Users (SWEG-JINFENG Users)

To change permissions, click Edit. Edit

Permissions for Administrators Allow Deny

Full control
Modify |
Read & execute
Read
I Wite I

opecial permissions

For special permissions or advanced settings, Advanced
click Advanced.

SUG501-1.5 13(22)




4 %A License Bl B 4.2 Windows R4t f} License L&

FHLE BB

LA Windows10 54t 95141 ifl % & Gowin License Server JF#LH 3l

B3, HiZJE3) 7 E L Administrator K 1217 .

1. HERREACEE S
ALY R4 N bat [HLAREESCHE, filln “startFloatingLicense.bat”, 7E
A EH AR SN ZE, W “start path\license_server.exe -s
path\gowin.lic -b”;

2. RHEALER SO DL JF ook
FIFFZATREHE (win #+R), Fi A4 : shell:startup, & 4-14 fior.
e 4, K 4-15 Fros it jE sk, # startFloatingLicense.bat
FEAL B SR DL BZ S B 30

4-14 BT < shell:startup

I Run >

—=  Typethe name of a program, folder, document, or Internet
o '\—_r|lll - . .
= rescurce, and Windows will open it for you.

Open: shell:startup o
QK Cancel Browse...
& 4-15 BRI K
- Mame Date modified Type Size
is
startFloatinglicense.bat  6/1/2020 3:533 PM  Windows Batch File 1t

3. AEINAEBNESZEH K.
FITH RS E A, W 4-16 Pior, AF startFloatingLicense.bat
Enabled, floating license JFHLH 3 3% & 3 -

SUG501-1.5 14(22)




4 #A% License Bt B 4.2 Windows R4 #1f License fit &

SUG501-1.5

& 4-16 (FEETEE

1%l Task Manager - O X

File Options View

Processes Performance App history Startup  Users Details Services

Last BIOS time: 7.1 seconds

Mame - Publisher Status Startup impact
B Intel® Graphics Command Center Startup Task IMTEL CORP Disabled MNone ~
!'| Realtek HD Audic Manager Realtek Semiconducter Enabled Low
| startFloatingLicense.bat Enabled Not measured
@ Waves MaxdAudio Service Application Waves Audio Ltd. Enabled Low
$ Windows Security notification icon Microsoft Corporation Enabled Low
WHXDrive Tencent Enabled High hd
Fewer details Disable

Windows IR B ZTh

LA Windows10 54t 441, A4Aandi] | shibflE Windows k%5 . k55
RE L ﬂAﬂﬁiﬁ,ﬁﬁfFﬂw,ﬁMHAN HIRIEH .
B, FERI Windows IR, H MR
1. iﬁ)\?ﬂﬂﬁﬁlfhibikﬂ#flEﬂi%
gowinLicenseServer\gowinLicenseServerForWindows\bin, 75 L
PRIz AT AL FE SCF “ gowinLicensingServiceAdding.bat”

2. BELVEBE AN A ITH a2 W H, ST B ST

“gowinLicensingServiceAdding.bat” .

AR S AR “Windows service has added successfully!”,
K] 4-17. bR, ARSSALTE Stopped IRZAS, il 4-18.
!

AR LAN BN IER, AT BLSAR G P AR G K s DA £ 48R 5 1E 5 1) P 2 0d R, A8
i ping T &M LAN @& 5 IE % .
& 417 Rzh&EO

E¥ Administrator: Command Prompt - gowinLicenseServiceAdding.bat — m] X

15(22)




4 #A% License Bt B 4.2 Windows R4 #1F License fit &

& 4-18 (F S ETEE

1% Task Manager — O e

File Options  View
Processes Performance App history Startup Users Details Services

=

Name PID Description Status Group 2
. gowinLicensingService gowinLicensingService Stopped o
Fewer details | ‘5 Open Services

Hk, TEARIRS, L EdRRS%FR “gowinLicensingService” A

Y, RS A 307 A =

1. #8474 sc start gowinLicensingService, #4758 )5 A LUB AT 45
HESEERE, Z78 “Running”, K& 4-19;

2. FHHAR RIMTSE LS, A gowinLicensingService, 1% #“ Start”,
B JE s RASN “Running”;

3. HE A%, Windows £ 31444 Windows k55

B 4-19 EHEER

17 Task Manager — O bY

File QOptions  View
Processes Performance App history Startup Users Details Services

o

Name PID Description Status Group 2
.. gowinLicensingService 11480 gowinLicensingService Running v
Fewer details | ‘54 Open Services

MRS FTHF =R AR license Manager & . 4118 4-20 fios, ¥
B AR S5 FE P ML 1P Huhk 3 5 75 B B 10 License Server”LL K Ji 3)) server
[ IHS R E I “Port”, B T “Check”, &ifih INFO {2/~ 1E, &
7~ “Serveris OK”. #%# floating license 55 %% IP Hihi A4 77 license A
BORELE H A, HIARSS B4 #LH. floating license F1) fE 30
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4 #A% License Bt B 4.3 Linux R84+ License it &

[&] 4-20 AL E Floating License

License Configuration

() Use Local Licenze File (@) Usce Floating License Server

License Server: |192.168.31.167 | Port

Check
i INFO W

Server is QK.
Address: 192,168.31.167:10559
Exp. date: 2022-10-26

QK
Apply for Licens _ Cloze

WUR TR ZEA& R MR RS, P DA 4
® fR5-#1k: sc stop gowinLicensingService

® % MHER: sc delete gowinLicensingService

4.3 Linux 24¥ 4 License it B

Linux £ 411 license Bt & /7 70—%L, LA Centos7.5 A1

DRI RIG, TIPSR 2 %) license HEATK 7, 1 5E license AN IE
i, AR RS R  Error $2~4E, WK 4-21 s, B “OK” J5,
i License Manager XFiEHE, 1l 4-22 FiR.
4-21 License Error {27~E

] ERRCOR X

License yerification failed,
connection imeout

P
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4 #A% License Bt B 4.3 Linux R84+ License it &

[# 4-22 License Manager X} i5HE

License Configuration
Use Local License File @ Use Floating License Sarver
License Server: |192.168.30.60| ] Port: 10538
Check
Apply for License B3§ License | 3 Close H ﬁgaue ‘

4.3.1 B EHIER License

F—IRECE license, I 7E K] 4-22 X 1EHEIZL$“Use Local License File”,
BT S8R license A, Hiifi “Browse:”, INIICHHIEEE . Bl
N7 “Check” $2H v] AR RE 5B i ), IEE I 23 INFO $27RHE,
{7 “License is OK”. MAC itk #1241 license A 20 - H I, anf& 4-23
fic. H#ii “Save” BIa[ {474 HIEC & .

WA P license FL &, PI{E AR, #idy “Help >
Manage License---”, 3} “License Manager” XfifHE, W1 4-22 fR,
R A] 55 3#7 license fit & .

4-23 T EHER license FEIER R RIE

¢ LicenseisOK.
w HostHD: 525400B8ABET
- Exp. date; 2022-10-22

P

4.3.2 2R8I License
1 4618 F Gowin License Server T. %A S license. mli@Ed AR
AP 20E 21

1. X “license_server” 33, 7 EKF A% license SCfF (I
gowin_license.lic)& #|#“license_server "Fr{EI% 1% T , K1 S % license
X4 N “gowinlic”, Wil “license_server”;

2. AT RS . $THF Terminal & 1, #4754 path/license_server -s
path/gowin.lic. 255 W& 4-24 Fix.
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4 #A% License Bt B 4.3 Linux R84+ License it &

[ 4-24 Gowin license Server BEhE O
[changhui@jinan9102 30]% ./license server -s gowin.lic

2021-09-30 10:47:24.102 =
Server started.
Local Address: 192.168.30.30
Listening Port: 10559
License Count: 50
E!
e -s: Jin#k license 14
o -p: fHEWHS, B\ 10559
o K license XA (41 gowin_license.lic) & % “license_server” T fE 42 R,
He %A “gowinllic”, F#r4 47 )53l Gowin License Server i, HFE#iA
path/license_server, 1 4-25 fifi7R.

[B 4-25 Gowin License Server BEIE
[changhui@jinan9102 30]% ./license server

2021-10-25 14:38:45.392 =
Server started.
Local Address: 192.168.30.30
Listening Port: 10559
License Count: 50

JBBEh 2 )G, 1E “License Manager” XiEHEF1%i A\ floating license
AR5 210 1P Hikt, ik 4-26 Frow.

4-26 Ft & Floating License

License Configuration
Use Local License File @ Use Floating License Sarver
License Server: |192,168.30.3p ] Port: 10538
Check
Apply for License B3§ License | 3 Close H ﬁgaue ‘

5 R 5 Check 74281 vl LA BE 5 & B2 i 0, IEE I 2 3 H INFO
PORHE, Wor “Serveris OK”. #2#U floating license KR5S %8 IP Hudik. i
-5 A1 24907 license A RUHELIEH B, & 4-27 Fros.
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4 {4 License fit &

4.4 License i JI i a) $2 i

[&] 4-27 ;25 BY License FEIER IR RIE

(3 Serveris OK
Y Address: 192,168.30,30:10559
- Exp. date; 2022-10-21

P

ANE AR license, TERCENFEHG, W2 H3E license it
B s BE5 NL % H ST i & SCH\IDE\bin\gwlicense.ini H, 1% 4-28 Fir
4-28 License Bt B 4

gwlicense.ini + ... IDEbIn) - GVIM1
File Edit Tools Syntax Buffers Window Help

SEXEa @ B &5 @& 6 &

1 [license]

z 1ic="192.16%.3D.3D:1D559ﬂ

FE!

W AP %E H 3T ECE SRR 2, TEiERAF gwlicense.ini S, i “Save”
VAR 25 TR B R o BRI TR BN gwlicense.ini SCEFEINRRYF “B N7 AR, 1F
LIHHAT T4 “chmod +x <file>” B A& M 4H-RUE .

4.4 License 1T HART E)IZHAE

SUG501-1.5

TEIRES license I /A 16 RIS, BRIRFT T84, A28 H license
AR TR PR IE, i 4-29 Fion. sl “OK”, BRI IEE A .
4-29 License 33 HART [E]$2ER

W Information >

o The license expires in 14 days.
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5 At 5 5l 5.1 Windows R 4445 5

5 N SY =

5.1 Windows &Gt EB

Ll Windows10 %5 91513 B .
5.1.1 GUI #X35h

W
Ml PREETT 3 “ms 7, Al R 3

® i “Zed HF\Gowin Vx.x.X\IDE\bin”, XU A AT A
“gw_ide.exe”;

® TJf omd WA M, B\« 223 H 3%\Gowin_Vx.x.X\IDE\bin\gw_ide.exe”;
® XUy TS AF.gprj.
512 S1TRI

£ cmd 4% 0, i\ path\IDE\bin\gw_sh.exe, f#i#E A\ fir 447 il B
X, BAE tol S VEN SUG100, Gowin = 4k 14/ ) 5 I I 5% A

5.2 Linux RS8R B3h
L Centos7.5 &4t N,
5.2.1 GUI 2\ 3 5h
® A “Z3EHF\Gowin_Vx.x.X\IDE\bin”, il $ 4T “gw_ide”;
® 7t terminal Tiz47 4 : path/Gowin_Vx.x.x/IDE/bin/gw_ide.
5.2.2 &ITRE

£ terminal i N\ fir4-: path/IDE/bin/gw_sh, #EAfrA4TiEHIR,
EAK tel 58 VEW SUG100, Gowin =54 EH 175 B Mt 3% A
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6 AR H 6.1 Windows R4 1B H

6 BEIR

6.1 Windows &R L
I DA 77 2GR H A
® i “File > Exit” 3,

o HMFIA AR ‘RS,

6.2 Linux R4 4R

JB L LAR 7 AR A
® i “File > Exit” M&Ii;
® IR AR s
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